
1 
 

 

 

 

 
iMapBC 

Training Manual 
 

 

 

 

 

 

 



2 
 

Contents 

Introduction to iMapBC ................................................................................................................ 6 

Starting iMapBC ......................................................................................................................... 6 

iMapBC Layout ........................................................................................................................... 7 

Other Features in iMapBC ........................................................................................................ 8 

Right-Click Options .................................................................................................................. 10 

Save and Open Projects .............................................................................................................. 11 

Save a Project ........................................................................................................................... 11 

Open a Saved Project .............................................................................................................. 12 

Home Tab ..................................................................................................................................... 13 

Home Tool ................................................................................................................................ 13 

Navigation Tools ...................................................................................................................... 13 

Find Data .................................................................................................................................. 14 

Export ........................................................................................................................................ 14 

Zoom To Tools.......................................................................................................................... 15 
Zoom to Coordinate Tools .................................................................................................. 15 
Zoom to District Lot Tool ..................................................................................................... 16 

Coordinates .............................................................................................................................. 17 
Generate Coordinates in the Map Window ....................................................................... 17 
Manually Entering Coordinates .......................................................................................... 18 
Managing Coordinate Callouts ........................................................................................... 19 

Managing All Coordinate Callouts ......................................................................................... 19 

Managing Individual Coordinate Callouts ............................................................................ 19 

Bookmarks ............................................................................................................................... 20 

Data Sources Tab ......................................................................................................................... 20 

Map Scale ................................................................................................................................. 21 

Layers Scale Dependencies .................................................................................................... 21 

My Layers.................................................................................................................................. 23 

Add Provincial Layers .............................................................................................................. 23 



3 
 

Working with Layers ................................................................................................................ 25 
Visualization by Attribute – Unique Values ........................................................................ 26 
Symbolize by Attribute –Class Breaks ................................................................................ 28 

Toggle Labels ........................................................................................................................... 29 
Customize Labels ................................................................................................................. 29 
Metadata URL ....................................................................................................................... 30 

Upload Data Tool ..................................................................................................................... 31 

Export Tab .................................................................................................................................... 32 

Print ........................................................................................................................................... 32 

GeoTiff URL ............................................................................................................................... 34 

Export Image ............................................................................................................................ 34 

Save Markup as Shapefile ....................................................................................................... 35 

Provincial Layer Download ..................................................................................................... 36 

Create Custom AOI (Area of Interest) Options ..................................................................... 37 

Draw a Custom AOI (Area of Interest) ................................................................................... 38 

Select a .zip File That Contains a Shapefile ........................................................................... 39 

Sketch Tab .................................................................................................................................... 40 

Draw Tools ................................................................................................................................ 40 
Enable Snapping .................................................................................................................. 42 
Select Snapping Layers ........................................................................................................ 43 

Edit Tool .................................................................................................................................... 43 

Grid Display Tools .................................................................................................................... 45 

Measure Tools .......................................................................................................................... 45 

Measure Distance .................................................................................................................... 46 

Measure Area ........................................................................................................................... 47 

Snapping Tools ........................................................................................................................ 48 

Select Snapping ....................................................................................................................... 49 

Find ............................................................................................................................................... 49 

Identify tools ............................................................................................................................ 49 
Enable Buffering .................................................................................................................. 51 



4 
 

Enable Snapping .................................................................................................................. 52 
Select Snapping Layers ........................................................................................................ 53 
Identifiable Layers ............................................................................................................... 53 

Working with Results ............................................................................................................... 53 
Results Overview .................................................................................................................. 54 

Detailed Result Menu Options ............................................................................................... 56 
List View and Table View ..................................................................................................... 57 
Open Saved Results ............................................................................................................. 58 
Save Results .......................................................................................................................... 59 
Combine Results .................................................................................................................. 59 
Add to Results....................................................................................................................... 60 
Subtract Saved Results ........................................................................................................ 61 
Match Intersecting Results ................................................................................................. 62 

Feature Location ...................................................................................................................... 63 

Select by Query ........................................................................................................................ 64 

Filter by Query.......................................................................................................................... 65 

Help............................................................................................................................................... 66 

Help Tab Tools ......................................................................................................................... 66 

Questions or Reporting Issues with iMapBC ........................................................................ 67 

Appendix A: Training Exercises .................................................................................................. 68 

Exercise 1: Search for an Address .......................................................................................... 68 

Exercise 2: Change Point Symbology ..................................................................................... 69 

Exercise 3: Symbolize by Attribute ......................................................................................... 71 

Exercise 4: Provincial Layer Download .................................................................................. 73 

Exercise 5: Select by Query ..................................................................................................... 76 

Exercise 6: Filter by Query ...................................................................................................... 81 

Appendix B: Finding Content on the DataBC Site .................................................................... 83 

Data Distribution Service ........................................................................................................ 83 

Web-based Mapping ............................................................................................................... 83 

Location Services (B.C. Physical Address Geocoder, Geomark Web Service, BC 
Geographical Names Web Service) ........................................................................................ 83 



5 
 

Topographic Data .................................................................................................................... 83 

Land Use ................................................................................................................................... 83 

Digital Imagery ........................................................................................................................ 84 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



6 
 

Introduction to iMapBC 

This manual looks at iMapBC tools and the advanced features included. This will help 
guide you through everything iMapBC can do. 

iMapBC is for viewing data all over British Columbia. You can make maps, save, reupload, 
and print them among many other things. iMapBC is a useful tool whether you have GIS 
training or not. 

 

Starting iMapBC 

To start iMapBC, open a web browser and go to the: DataBC Geographic Services home 
page. Click iMapBC. 

In the window, there are two options: 

1. Launch iMapBC 
2. Launch iMapBC (username required) 
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iMapBC Layout 

The iMapBC interface has five main sections. 

 

 

 

 

  

 

 

 

 

 

1. Toolbar Tabs: The toolbar has 5 tabs where all tools are. The sections are: Home tab 
(navigation tools), Data Sources tab (add information to the map), Export tab 
(Moving data off iMapBC), Sketch tab (draw on the map), and the Find tab (learn 
more about map layers). 
 

2. Toolbar: In each tab, this contains more specific tools that are organized into 
groupings based on what they do. 
 

3. Information Panel: This shows different kinds of information as you use the map. For 
example, it shows ‘Map Layers’, where you can select which layers of the map to hide 
or show, or the ‘Results List’, which lists map features when you search or use the 
‘Identify’ tool. 
 

4. Map Window: This is where you can zoom in, pan, and right click on the map to get 
more information. 
 

5. Overview Map: The overview displays a thumbnail of the map and its surroundings, 
with it starting as a small square. The Overview Map can be minimized by clicking the 
arrow at the bottom left of the map window. Also, dragging the current view box will 
bring you to that location in the map window. 



8 
 

Other Features in iMapBC 

iMapBC shows these features: 

 

 

 

 

 

 

 

 

 

 

 

1. I want to…’ Menu: A menu of shortcuts to popular tools. This includes the ‘Save’ and 
‘Open’ project tools. 
 

2. Search Box: Type the name of a feature or a street address into  this box to search 
for it on the map.  
 

3. Display / Hide Toolbar Icon: This icon shows or hides the toolbar when clicked. 
 

4. Right Click Menu: This lets you get more info on the spot you clicked and let you 
use tools to mark that spot. More info is available below. 

These icons will help you get different types of information. The data is most often shown 
in the 'Information Panel’ on the left, like map layers, and search results. 
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5. Base Map Options: Click to show 
different base map options, like 
satellite imagery. This will change the 
map background image that is in the 
map window. 

 
6. Coordinate Options: Let’s you view and 

change the default coordinate system 
shown in iMapBC. The coordinates 
system in this section relates to the 
map centre location. 

 
7. Scale Input Box: Allows the user to 

change the current map scale from a 
set of predefined map scale options. 

 
8. The Scale bar shows how much space 

shown on the map relates to the space 
in the real world. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The ‘Roads’ option will not show visuals on a scale of 1:2257 and 
below. 



10 
 

Right-Click Options 
Right click in the map window to display options and tools based on the location clicked in 
the window. 

 

 
 

 

 
 
 

1. This shows the coordinates of the 
clicked location in the map window. 
 

2. Find data on the map: Allows the user 
to use the ‘Identify’ tool on any added 
layers where you clicked. 

 
3. Draw a Point: Draws a point in the map 

window. 
 

4. Plot a Coordinate: Creates a coordinate 
callout in the map window. 

 
5. Add Some Text: Allows the user to 

enter and place text in the map 
window. 

 
6. Center the Map Here: Centers the map 

window to the clicked location. 
 

7. Route From: Adds a starting address to 
the route planner. 

 
8. Route To: Adds a stop to the route 

planner. 
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Save and Open Projects 
iMapBC projects are saved to your computer and can be retrieved. Save and Open session 
options can be used on the ‘I want to…’ menu. 

 

Save a Project 
 

 
 

 

 To save a project: 
 
1. Click ‘I want to…’. 

 
2. Click ‘Save’. 

 
3. The Save Project’ screen will open in 

the information panel. 
 

4. Give the project a Name and 
Description. 

 
5. Click ‘Save’. 
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Open a Saved Project 
 

 

 1. Click ‘I want to…’ 
 

2. Click ‘Open’. 
 

3.  A new window will open in the 
information panel, warning that it will 
change your current map. Click ‘Ok’. 

 
4. A menu will open in the information 

panel asking for a .gvhp file, click 
‘Choose File’. 

 
5. Your file explorer will open, upload 

your .gvhp file and it will show more 
info on your map. Click open and your 
map will load. 

 

You can sort the projects shown in the Projects window by using any of the following 
options: 

• ‘Filter Projects…’ allows you to filter by the project results. This will filter results by 
both project name and description. 
 

• ‘Show my projects only’ will only display projects that you have created. 
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Home Tab 
The ‘Home’ tab contains many of the popular tools in iMapBC. 

 

Home Tool 
The ‘Home’ tool opens the home screen information in the ‘Information Panel’. The home 
screen panel has quick links to popular tools in iMapBC. It also has a link to learn more 
about iMapBC through the Geographic Data & Services page. 

 

 

 

 

Navigation Tools 
The Navigation tools lets you move around the map window. This includes the following 
tools:  

Click a location on the map and drag it to another location on the map with the 
‘Pan’ tool. 

 

The ‘Zoom In’ tool can be used two ways: 

Point Click the map once to zoom in to half of the current scale. 

• Hold the mouse button down and draw a box. 

You can also zoom in at any time by: 

• Rolling your mouse wheel forward 
• Pressing the + (plus) key on the keyboard 
• Using the zoom slider 
• Double clicking anywhere in the map window 

 

The ‘Zoom Out’ tool can be used two ways:  

Point Click the map once to zoom out to twice the current scale. 

• Hold the mouse button down and draw a box. 
• You can also zoom out at any time by rolling your mouse wheel backward. 
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• Pressing the minus key on the keyboard Using the zoom slider. 

 

The ‘Full Extent’ tool zooms to the full size of B.C.      

 

The ‘Back’ tool zooms to the last map extent. 

 

The ‘Forward’ tool zooms to the next map extent. This tool will appear grayed out 
until you have used the ‘Back’ tool. 

 

Find Data 
The only tool in the Find Data section of the home tab is ‘Identify’ . This lets the 
user learn more information about features clicked in the map window. This tool is 
described fully below in the Identify Tools section. 

 

Export 
The only tool in the Export section of the home tab is the ‘Print’ tool. This lets the 
user print out the map you made. This is better described below in the Print tool 
section. 
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Zoom To Tools 
The ‘Zoom To’ tool grouping has tools that can be used to move to specific locations. You 
can find areas based on exact coordinates or district lots. 

 

Zoom to Coordinate Tools 
 

Albers tool 
 
 
              

Lat/Long tool 
 

UTM tool 
 

District Lot tool 
 

 

 

 
 

The zoom to coordinate tools follow the 
same rules (UTM is used on the left). 
Click the desired coordinates tool. 
 
1. In the Information panel, enter the 

coordinates you want to go to. 
 

2. ‘Extent Width’ allows you to select the 
width of the map. 
 

3. Click the ‘Go to Coordinates’ button. 

 

Note that you also need to enter the UTM zone for the ‘UTM’ tool. 

 

 

 

 

 

 

 

The distances zoomed to from the Extent width’ pull-down menu 
is approximate. 
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Zoom to District Lot Tool 
The ‘District Lot’ tool opens the ‘Zoom to District Lot’ window in the information 
panel. It allows the user to zoom to a specified district lot using the legal parcel 
information input method. 

 

  Users can search for a District Lot using 4 
different options: ‘PIN Number’, ‘Section 
Township Range’, ‘District Lot’, or ‘Search 
All’. 
 
The results can be filtered by checking 
the ‘Filter results by land district’ option 
and then picking a Land District. 
 
1. Enter a ‘PIN Number’ (i.e., 3916200) 

 
2. Enter a ‘Section, Township, and 

Range’ (i.e., Section 3, Township 28). 
 

3. Enter a ‘District Lot’ (i.e., 1605). 
 

4. Enter any of the Legal Description to 
in the ‘Search All’ field (i.e., 1605, 
SDYD). 

 
 

 

 

 

 

 

 

 

If the Land Districts – Tantalis and Land Act Survey Parcels - 
Tantalis layer was not added before by using the 'District Lot' 
tool, it will be added to your layers. 
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Coordinates 
The ’Plot Coordinates’ tool lets the user create coordinates that will be added to the map 
window. The user can do this using two methods: 

• Generate coordinates in the Map Window (see the Generate Coordinates in the 
Map Window section). 
 

• Manually Enter Coordinates (see the Manually Entering Coordinates section). 

 

Generate Coordinates in the Map Window 
Click the ‘Plot Coordinates’ tool and click any location on the map. A callout will be placed 
at that location using the defined coordinate system of the map. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You can click the map repeatedly to place additional coordinate 
callouts. 
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To change the Coordinate System for the callouts, pick a 
Coordinate System from the drop- down menu and make any 
required changes. 

Manually Entering Coordinates 
 

 The user also has the option to manually 
enter coordinates to create a callout in 
iMapBC. 
 
1. In the Plot Coordinates window click in 

an empty coordinates text box. 
 

2. Enter your known coordinates 
(including North and West). 

 
3. Click ‘Add’, and it will be added to the 

map. 
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Managing Coordinate Callouts 
Coordinate callouts can be managed using several different tools outlined in the sections 
below. 

 

Managing All Coordinate Callouts 
 

 
 

 

1. The menu option (To the left of the ‘x’) 
lets you edit all your coordinate points. 
 

2. ‘Hide All Coordinates’ will remove all 
the coordinate points from your map, 
but not delete them. 

 
3. ‘Delete All Coordinates’ completely 

removes all old coordinate points. 

 

Managing Individual Coordinate Callouts 
 

 
 

 

1. Click the ‘…’ option to the right of a 
coordinate to manage that callout. 
 

2. ‘Hide Coordinate’ will hide the point. 
 

3. ‘Edit’ will let you change your point and 
move it. 

 
4. ‘Delete’ to remove the point from the 

Plot Coordinates list. 

 

 

 



20 
 

Bookmarks 
The ‘Bookmark’ tool lets you save a specific area that you plan to return to later in 
the same iMapBC project. 

 

 
 

 

To create a new bookmark: 
 
1. Click the ‘Bookmark’ tool. 

 
2. The Bookmarked Locations window will 

open. Click ‘Bookmark Current Extent’,  
 

3. Enter a name for the bookmark, and 
then click ‘Ok’. 

 
4. The bookmark will appear in 

Bookmarked Locations list and enable 
you to return to this same area. 

 
To open an existing bookmark: 
 
1. Click the ‘Bookmark’ tool, which will 

open ‘Bookmarked Locations’. 
 

4. Click the bookmark you want to open. 
 

Data Sources Tab 
The tools under the ‘Data Sources ‘tab lets you add layers from the B.C. Geographic Data 
Warehouse (BCGW). It also lets you upload your own spatial and coordinate data. When 
using layers, it’s important to understand map concepts and tool options. This includes 
scale, layer scale dependencies, and layer order. 
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Map Scale 
When you zoom in, the scale of the map increases - getting larger. A large-scale map 
covers a smaller land area than a small-scale map. A map that is zoomed in to a small 
town is large-scale, while a map of British Columbia is small scale. 

Small Scale Map Example 
 

 
 

Large Scale Map Example 
 

 

Explanation: Scale is a ratio; 1:10 means that the map is one-tenth the size of the real-
world area it represents. If you have a 1:100,000 map, the map is 1/100,000 the size of the 
actual place. 

The map’s scale is in the status bar below the map window. The scale adjusts as you zoom 
in and out on the map. 

The Scale Bar can be adjusted by selecting one of the pre-populated scales in the list of 
options or manually typing in one of the scale presets. 

Scale varies according to monitor, resolution, and size of the browser window. For 
example, full extent scale might be 1:12,000,000 on one monitor and 1:7,600,000 on 
another. 

 

Layers Scale Dependencies 
Scale dependencies are set up so that single layers' visibility changes at specific scales. The 
layer symbology can also have specific scale dependencies, or renders. A city might be 
shown as a tiny polygon that looks like a dot on a small-scale. On a larger scale, the entire 
city boundary may have an outline and fill colour. 
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Clicking the ‘Zoom to Visible Scale’ option will not change the 
map window location. You may need to check around the map 
to find the visible features. 

 
 

 
 

 

1. When a layer is not shown at the 
current scale, its name will be grayed 
out. 

 
2. When a layer is shown at the current 

scale, its name will be black. 
 

3. To zoom to a scale where the layer is 
visible, click the arrow to the right of 
the layer name.  

 
4.  In the layer detail options select ‘Zoom 

to visible scale’. 
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My Layers 
The ‘My Layers’ tool opens the layer list for iMapBC. All layers that have been 
added to the session are displayed. 

 

Add Provincial Layers 
The ‘Add Provincial Layers’ tool lets you use layers from the B.C. Geographic Data 
Warehouse (BCGW). The BCGW is a database with more than 2000 unique layers with 
every type of spatial info used by the B.C. government. 

 

 

 

 

 

The BCGW layers are provincial in scope, but there are groups of layers named with the ‘L_’ 
grouping. Some are specific to areas of the province sometimes called ‘Local’ or ‘Regional’ 
layers. In these cases, the layer will include the area it applies to in the file name. The 
example below will go more in depth on this. 

 

 
 

 
 

 

To use the ‘Add Provincial layers’ tool: 
 
1. Click ‘Data Sources’ on the toolbar. 

 
2. Click ‘Add Provincial layers’. The 

‘Data sources’ tab and the 
Add/Remove Map Information 
window will open. 

 
3. Find the layer you are looking for 

by browsing through folders or 
entering text in the search box. 
Clicking a box will give you layers 
to add to your map. 

 
 

Almost all layers are open for the public to use, but there are 
some are restricted. Special layers that are part of wildlife areas 
and archaeological sites are unavailable for public use. If these 
layers are not available to you, they will not be shown when 
adding layers, and you will need to ask for special permission. 
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Most layers will have a colour-filled type layer and an outlined 
layer.  You can use one or both of layers on the map. 

 
 
 
 
 
 
 
 
 
 
 

 
 

4.  If you have typed into the search 
box and want to remove it, click 
the ‘X’ to the right of the search 
bar. 

 
5.  A check mark will be placed in the 

box when it is clicked. Click ok to 
add the layers to the iMapBC layer 
list. 
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Working with Layers 
Once layers have been added to the iMapBC ‘Layers’ list in the information panel, the way 
they are displayed in the map window can be changed in many ways listed below. 

 

 
 

 
 

 
 

 
 

1. Clicking on the box to the left of the 
layer in the ‘Layers’ list removes it from 
the map. Clicking the box again will 
bring the layer back. 
 

2. To use advanced layer options, you 
need to click the arrow to the right of 
any layer name. From there you can 
use the tools to change the layer you 
clicked on. All layer options are 
accessed by clicking this arrow. 

 
3. You can zoom to the full extent of the 

dataset by clicking the arrow to the 
right of the layer name. That will open 
the layer options. Then click the ‘Zoom 
to full extent’ option. 

 
4. You can zoom to where the layer will be 

shown by clicking ‘Zoom to Visible 
Scale’. If it still doesn’t show up, pan 
around the map to find the points. 

 
5. How a layer looks in the map can be 

changed by clicking the ‘Turn on/off 
layer visualizations’ option. Layers can 
be made up of points, lines, or 
polygons. Changing each layer’s 
visualization is done in similar ways. 
Changing a layer’s characteristics is 
based on their geometry type. 

 
6. Clicking ‘Remove Layer’ will remove it 

from your current map. 
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When the ‘Select a visualization for your layer:’ option opens, there are two choices 
available: 

1. None: This will return the layer to the default layer symbolizations. 
2. Custom Layer Style…: This will allow you to make your own custom visualizations 

for a layer. 

 

Visualization by Attribute – Unique Values 

 
 
 

1. You can change layer 
visualizations, ‘Simple’ makes each 
feature in the layer appear the 
same way. ‘Attribute’ lets you 
change how a layer looks based 
on some traits you can pick.  
‘Attribute’ creates values that will 
change points based on their 
differences. 
 

2. ‘Pick an attribute to symbolize’ 
(where you create values from) 
will be different based on what 
layer you customize. You can only 
pick one attribute to symbolize at 
once. 

 
3. ‘Transparency’ allows you to 

change how much you can see 
through a layer. 

 
4. ‘Marker Size’ (point layers only) 

allows you to change the size of 
the point feature symbol. 

 
5. ‘Line Width’ is the thickness of the 

outline surrounding the feature. 
 

The 'Unique Values' option shows groups of features. The groups have matching traits, 
(school types, soil types, classifications, etc.). If there are more than 12 different values 
for a trait, only the first 12 will be used. 
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The symbology for each feature can be done separately. 

6. ‘Marker Style’ (point layers only) lets you change the shape of the marker symbol. 

 

7. You can change the colours of your point types. The example here (School Type) 
will affect all points that apply in B.C. If you pick an attribute such as ‘Address’, it will 
only apply to 12 points within the map window (only ideal for large scale maps). 

 

Once the layer has been customized: 

• Click ‘Apply’ to make the layer changes in the map window but keep the 
Visualization Options screen open.  
 

• Click ‘Done’ to keep the changes in the map window and close the Visualization 
Options screen. 
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Symbolize by Attribute –Class Breaks 
The 'Class Breaks Symbolization' type makes each feature look different. For it to work the 
layer needs to be customized. The ‘Visualization Options’ window will open in the 
information panel. 

An example where 'Class Breaks Symbolization' could be used is to find the age of trees in 
a vegetation layer. When customizing your layer, you can organize the data by ‘Projected 
Age’. From there you can change what age ranges are shown to best fit your map. 

 

 
 

These options are for changing how layers 
look on your map: 
 
1. ‘Choose Symbology Type’ needs to be 

set to ‘Attribute’ to make changes. 
 

2. ‘Pick an attribute to symbolize’ will need 
to be an option about numbers (For 
example ‘Projected Age’. 

 
3. The ‘Classes’ section lets you pick how 

many different groups will be shown. 
You can change what belongs in each 
group in the bottom section (step 8). 

 
4. The ‘Start Color’ sets the start colour of 

your first group. The colour will 
gradually change from each group to 
the 'End Colour'. 

 
5. The ‘End Colour’ sets the colour of the 

last group. 
 

6. The ‘Transparency’ option lets you pick 
how see-through you want the layer to 
be. 

 
7. ‘Line Width’ is the thickness of the 

outline around the feature. 
 

8. You can change the values for each 
group making them larger or smaller. 
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When the changes have been made: 

• Click ‘Apply’ to make the changes in the map window but keep the Visualization            
Options screen open. 
 

• Click ‘Done’ to make the changes appear in the map window and close the 
Visualization Options screen. 

 

Toggle Labels 
If your layer has labels, they can be toggled on or off by clicking the arrow to the right of 
the layer name. Open the layer options and select the ‘Toggle labels’ function. If no labels 
have been set up for the layer, this can be done using Customize Labels. 

 

Customize Labels 
You can make or change labels for a layer by clicking the arrow to the right of the layer 
name. Open the layer options and select the ‘Customize labels’ function. 

 

 
 

The customize label screen will open. The 
user will be able to select: 
 
1. ‘Show Labels’ will turn the label visibility 

on/off. 
 

2. Pick the layer trait in ‘Field’, that will be 
used to generate the labels. Each layer 
will have different options to choose 
from. 

 
3. Choose a colour for your label. 

 
4. Set the Font Size. 

 
5. Click ‘Apply’ and it will load onto your 

map. 
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Once the label has been customized: 

• Click ‘Apply’ to make the label changes in the map window but keep the customize 
label screen open. 
 

• Click ‘Done’ to make the label changes in the map window and close the customize 
label screen. 
 

• If there were labels for the layer, the user can click ‘Reset to Default’ to return to the 
layers default label. 
 

• Click ‘Cancel ‘to ignore any changes and close the customize label screen. 

 

Metadata URL 
Metadata is called 'information about information' or 'data about data'. The BC Data 
Catalogue (or BCDC) is where you can get metadata and will explain everything about it 
too. The Freedom of Information and Protection of Privacy Act includes exactly how 
Government information is used. BC Data Catalogue metadata records work for all the 
layers added from the ‘Add Provincial Layers’ tool (BCGW layers). 

To use metadata for a layer, click the arrow to the right of the layer name in the ‘Layers' 
list. Open the layer options and select ‘Metadata URL’. 

A new window will open, and the layer's metadata record will be shown. 
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Upload Data Tool 
The ‘Upload Data’ tool lets you upload spatial or coordinate information from 
your computer into iMapBC so it can be viewed. When you click the ‘Upload Data’ 
tool it will open a new window over the map window. 

 

These data formats are good to use as input data layers when using the ‘Upload Data’ tool: 

• .csv – comma separated values containing coordinates saved in a table. 
• .xlsx – Microsoft Excel file with coordinates saved in a table. 
• .kml – Google earth  files. 
• .shp – ESRI shapefiles. 
• .gpx – GPS Exchange Format, is a common GPS data format for waypoints or 

coordinates. 
• .zip – Compressed file that contains either a shapefile or File Geodatabase. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When uploading files, you need to make sure that you select all 
the relevant files. For data set make sure it is all the files 
required, and for shapefiles make sure it is all the associated 
files or it will not be added to iMapBC correctly. 

When picking a shapefile, all these components of a shapefile 
need to be included for it to work (cpg, .dbf, .prj, .shp, and .shx).  
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Export Tab 
The ‘Export’ tab is for users to get information in different ways from iMapBC. These 
different ways let people use the data on many websites and programs. You can get the 
data as an image, a printed map, or by downloading the data to your computer. 

To use the ‘Upload Data’ tool: 

1. Click the ‘Data Sources’ tab and click the ‘Upload Data’ tool. 
2. In the ‘Add Data to Map ‘window, click ‘Choose Files’ 
3. Navigate to where your data is saved in your file explorer, then click ‘Open’. 
4. Click ‘Upload’ to add the layer to the map window. 

 

Print 
The ‘Print’ tool lets you make a map that can be saved, and later sent to a printer, 
copied to a document, or emailed to other people. When you click ‘Print’ in the 
‘Export’ tab it will bring up the ‘Print Map’ screen in the information panel on the side. 

Many types of printing templates have been made to use in iMapBC. In these 
templates, map titles and data entry boxes for specific content are here to change 
the templates for use. 
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1. Select your print layout. 
 

2. Set the map output format. This can be 
PDF, TIFF, BMP, GIF, or JPEG. 

 
3. Set to either High or Low Resolution. 

 
4. Add the Latitude / Longitude in the 

‘Grid’ column. 
 

5. Set the map scale of the output map. 
This can be a set scale, the current 
extent (what is seen in the current 
map), or the current map scale. 

 
6. Give the map a title. 

 
7. Click the ‘Print’ button. 

 
8. In the Create Printable Map screen, 

click the ‘Open File’ button to view the 
map output. 

 
 

 

 

 

 

 

 

 

 

 

The scale of map may not show all your layers when printed. 
Please look over your scale before and adjust it so all layers are 
there. 
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GeoTiff URL 
‘GeoTIFF URL’ creates a URL link that lets you share the map as a GeoTIFF image 
with others. Using this tool lets you input data into Avenza Map. 

 

 

 

 

 

 To use the ‘GeoTIFF URL’ tool: 
1. Click the ‘GeoTIFF URL’ tool on the 

‘Export’’ tab. 
 

2. The GeoTIFF will be created. You can 
copy and paste the URL from the text 
box to share with other users. 

 

Export Image 
The ‘Export Image’ tool makes images of the Map Window in PNG, BMP, JPEG, 
TIFF, GeoTIFF, and PDF formats. You can export the images, including 
georeferenced data and can be used to import the images into a GIS platform. 

 

 
 
 
 

To use the ‘Export Image’  tool: 
 
1. Click the ‘Export Image’ tool on the 

‘Export’ tab. 
 

2. In the first ‘Export a Map Image’ box, 
pick the image format and check the 
box if you would like the file to include 
georeferencing information. Then click 
the ‘Create Image’ button. 

 
3. In the second ‘Export a Map Image’ 

box, click the ‘View Image’ button. 

A GeoTIFF image shows georeferencing information in a TIFF 
file. You can see this image with other types of map data in 
other software that are public domain. 
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Save Markup as Shapefile 
‘Save Markup as Shapefile’ exports any Markups you made using the ‘Draw’ tools as a 
shapefile. Markups can be drawings created from the ‘Sketch’ tab, measurement 
drawings, or buffered identify drawings. 

The shapefiles created will be exported in the Web Mercator projection. A shapefile is a 
common format for GIS staff to use in other applications. 

 

 
 
 
 

 

To use the ‘Save Markups as Shapefile’: 
 
1. Create your markup. 

 
2. Click the ‘Save Markup as Shapefile’ tool 

on the ‘Sketch’ tab. 
 

3. Select a spatial reference in the pop-up 
window. 

 
4. Depending on your internet browser, a 

download dialog box will open. Click 
‘Open’ to view the download contents. 

 
5. A zip file will open with your shape file. 

You can email the zip file to a GIS user 
or extract the shape file to a location on 
your network. 

 

 

 

 

 

 

 

A shapefile will have files associated with it (.cpb,.dbf, .prj, .shp, 
.shx). All five of the files are needed to view the shapefile in a GIS 
viewer. Most viewers also need the .prj file to determine the 
projection of the feature. 

The image file will be put in a zip file which you can then open or 
save where you want. 
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Provincial Layer Download 
‘Provincial layer Download’ lets you extract layers from iMapBC to use in other 
applications. 

You can change the extent of the data, the data clipping method, and the output format. 
To use the ‘Provincial Layer Download’ tool: Add the layers to your iMapBC session using 
the ‘Add Provincial Layers’ tool from the ‘Data Sources’ tab. 

 

After clicking ‘Prepare Order’ a new window will open. From this window, these are some 
of the following options. 

 

 

 

 

  

 

 

 

 

 1. Click the ‘Provincial Layer Download’ 
tool on the ‘Export ‘tab. 
 

2. In the ‘Data Download Service’ screen, 
Toggle the layers in the list that you 
want to download. You can also use the 
‘Select All’ option to toggle all layers on 
or the ‘Clear All’ option to toggle all 
layers off. 

 
3. When you have all your layers selected 

click ‘Prepare Order’. 
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1. ’Coordinate System’ lets you select the 
coordinate system that will be used for 
your map. 
 

2. ‘Format’ will allow you to select your 
download output format. 

 
3. ‘Area of Interest’ lets you make choices 

to define your data download selection 
extent. ‘No Area of Interest Applied’ will 
not apply any further area of interest to 
your download extent.  

 
4. Enter your email address and agree to 

the Terms and Conditions, then click 
‘Submit Order’. 

 
After clicking ‘Submit Order’ you will get 
two emails. One will be to tell you that you 
order was submitted, the second email will 
have your order details and a URL to the 
data package. 

 

 

 

 

 

 

Create Custom AOI (Area of Interest) Options 
This section explains the ‘Draw a Custom  AOI’ option from the ‘Area of Interest’ selection 
in the Current Order window. You can do this by first clicking the ‘Provincial Layer 
Download’ tool then clicking prepare order, which will open the Current Order window. 
From there click on the ‘Area of interest’ column and select ‘Draw a Custom AOI’ Visuals. 
There are two Custom AOI options: 

 

 

If the ‘% of Max’ exceeds 100%, you will need to remove layers or 
set an area of interest to reduce the size to below 100%. 



38 
 

Draw a Custom AOI (Area of Interest) 
Click the ‘Draw a custom AOI’ tool to open the AOI Selector map window. 

 

 

 

 

 

 

 

 

 

 

 

 

To draw a custom AOI: 

1. Zoom to the location in the map window where you want the AOI. 
 

2. In the ‘Select Area of Interest’ screen, click the geometry option to be drawn. 
 

3. In the map window, draw your AOI. If drawing a polygon, click to add each point 
and double click to complete the geometry. 
 

4. Once the geometry has been drawn, the ‘Select Area of Interest screen will state: 
‘Geometry captured’. 
 

5. Click ‘Next’. 
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 The ‘Select Area of Interest’ screen will 
show these options: 
 
1. ‘Remove Polygon’: Removes the 

polygon as an AOI. If there is only one 
point in the map window the shape 
will be removed. If there is more than 
one AOI shape, you will be asked to 
select which AOI is to be removed. 
 

2. ‘Add More Polygons’: Lets you make 
another shape to use as an AOI. 

 
3. ‘Submit AOI’: Will close the AOI 

Selector window and set the shape as 
the AOI. 

 

Select a .zip File That Contains a Shapefile 
You can also use a shapefile that is stored in a .zip file to use as a Custom AOI. 

 

 

 

 

 

 

 

 

 

 

 

To use a .zip file as the custom AOI: 

1. Set the Area of Interest to ‘Draw a Custom AOI’ and click ‘Choose File’. 
2. Go to the location where the zip file is created and click ‘Open’. 
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Sketch Tab 
The iMapBC ‘Sketch’ tab has tools to draw your own material on the map. These tools have 
many uses, like marking corrections to a data layer and submitting them to your data 
custodian. 

 

Draw Tools 
The nine Draw tools all follow the same pattern of use: 

 

  

 

 

 

 

 

 

 

 

 
1. Click the ‘Polygon’ drawing tool under the ‘Sketch’ tab. 

 
2. When you pick the ‘Polygon’ tool, you can turn on ‘Enable Snapping’ and ‘Style’ 

tools. The ‘Style’ tool can be used to set the symbology of the polygon you are 
drawing. 

 
3. Click the first point on the map, and the first point of the polygon will be drawn 

there. 
 

4. Continue clicking points until your shape is complete. Then double click to finish 
the polygon. 
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All 9 of the basic draw tools are described in this table: 

Tool Action 

 
Click ‘Point’, and then click anywhere on the map. 

 Click ‘Text’, and then click anywhere on the map. 
Type the text you want to add at this location on the map and click ‘Ok’. 

 
  

Click ‘Line’, and then drag across the map to draw a line. 
To continue the line but change direction, click, and then drag in the new 
direction. To end the line, double-click. 

 

Click ‘Freehand’, and then draw in any direction on the map to create a 
line drawing. 

 
Click ‘Freehand Shape’, and then drag across the map. 

 Click ‘Ellipse’, and then drag across the map to draw an ellipse. 
The ellipse draws from the corner of the shape, so you can change the 
shape by moving the cursor up and down or sideways. 

 Click ‘Circle’, and then drag away from that spot to draw the shape. 
The circle draws from the center out, so the further you drag your cursor, 
the bigger the circle will get. 

 Click ‘Polygon’, and then drag across the map to start a polygon. 
To change direction, click and then drag in a new direction. The shading  
shows that the polygon is filling in the space of the area made by your 
drawing. Double-click to end the polygon. 

 Click ‘Rectangle’, and then click one corner of the rectangle you want to 
draw.  
Drag away from that corner and a shaded rectangle will form under your 
cursor. 
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Enable Snapping 
When drawing markups, you can snap your points to existing markups on the map. 
Snapping is useful as it makes it easier to draw to the exact point on the map. Snapping is 
only a feature available for the ‘Polygon’ and ‘Line’ sketch tool. 

 

Click the ‘Enable Snapping’ option and either the ‘Line’ or ‘Polygon tool. You 
can disable snapping at any time by pressing the same button which will be 
labeled as ‘Disable Snapping’. 

 

 
 

 

 1. After drawing your first shape and 
enabling snapping, your mouse will 
attach to the edges of your last 
shape. You can now draw your new 
shape with no overlap or missed 
area. 
 

2. After drawing your new shape and 
double-clicking to finish it you will 
see that snapping is still enabled. 
You can snap together any number 
of shapes to modify your map. 

 

 

 

 

 

 

 

Only drawn features can be used for snapping. BCGW layers are 
not enabled for snapping. 



43 
 

Select Snapping Layers 
Layers are currently not enabled for snapping in iMapBC. The function will be added in a 
later update. 

 

Edit Tool 
The ‘Edit’ tool is used to move, edit, or restyle the geometry of a drawing in the map 
window. 

To edit a drawing: 

1. Click the ‘Edit’ tool. 
2. Click the drawing to be edited.  Each vertex in the shape will be shown as a dark 

grey circle. 
3. Make any of the edits listed below. 
4. When you are finished editing, double-click outside of the shape to complete edits 

to your sketch. 

 

Edit Process Image 

Move Vertex Left click and drag a 
point (grey circle) to its 
preferred location.  
 
Release the button to set 
the location of a vertex. 

   

Add Vertex Click on one of the white 
circles between the 
vertices (larger grey 
circles). 

 

  

 

Delete Vertex 
 

Right click on a vertex (grey 
circle). The ‘Delete’ option 
will appear. 
 
Click ‘Delete’ to remove the 
vertex. 
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Resize Drawing Left click and drag one of 
the white squares 
around the drawing to 
resize the drawing. 

  

Move Drawing Left click and drag in the 
center of the drawing to 
move the shape to a new 
location. 

  

Rotate Drawing Left click and drag the 
white square at the top 
centre of the drawing to 
rotate it. 

  

Restyle Drawing On the Sketch toolbar, 
click the ‘Styles’ tool and 
select your style 
preference. 
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Disclaimer: Do not use this tool for formal business decisions. It is not a 
fully accurate tool. The measurements are not legal due to the varying 
topography of Earth. We recommend not relying on this measurement. 

Grid Display Tools 
The ‘Add a Grid’ tool adds a grid to your current map extent. The grid added 
does not follow any lines of latitude or longitude. 

 

 

 

 

 

 

 

 

 

 

To add a grid: 

1. Select the ‘Add a Grid’ from the Sketch tab. 
2. In the ‘Enter Number of Columns and Rows’ screen, select the preferred options 

and click ‘OK’. 
3. The map will be divided into the defined grid pattern. 
4. To remove a ‘grid’, click ‘Clear Grid’ from the ‘sketch’ tab. 

 

Measure Tools 
The measure ‘Distance’ and measure ‘Area’ tools are simple tools for drawing features and 
measuring distance and area. 
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Measure Distance 
The ‘Distance’ tool in the ‘Sketch’ tab is convenient for measuring linear paths and 
area on a map. 

 

 

 

 

 

 

 

 

 

 

 

 
1. Click the measure ‘Distance’ tool. 

 
2. After you click the start point for the line feature to measure, move your mouse 

away, and click. A black label will appear showing how far the mouse location is 
away from the last point. 
 

3. Continue clicking points until your line feature is complete, double clicking your last 
point to finish. Each section will be labeled with its length in the white box, and its 
total distance will be shown in black at the end. 
 

4. You can change how distance is shown during or after creating the distance 
measurement. Set the units for the 'Distance' and 'Area'. 
 

5. To remove the measured line shown on the map, click the ‘Clear’ tool (in the Edit 
Drawings section when you are finished). 
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Measure Area 
The measure ‘Area’ tool is for measuring straight paths on the map. To use the measure 
‘Area’ tool: 

 

 
 

 

1. Click the measure ‘Area’ tool. 
 

2. After you click the start point for the 
polygon feature to measure, move your 
mouse away, and click. A black label will 
appear showing how far the mouse 
location is away from the first point. 

 
3. Keep clicking points until your polygon 

feature is completed. It will show the 
total perimeter, and the length of each 
section in the white boxes. The area will 
be shown in black in the centre of the 
measured area. 

 
4. You can change the units of display 

during or after creating the distance 
measurement. Set the units for the 
‘Distance’ and ‘Area’. 

 
5. To remove the measured line shown on 

the map, click the ‘Clear’ tool (in the Edit 
Drawings section) when you are 
finished. 
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Snapping Tools 
When drawing markups, you can snap your points, to markups or 
measurements on the map. Snapping is useful because it makes it easier to 
draw to the exact point on the markup. You can disable snapping at any time 
by clicking the same button again now labeled as ‘Disable Snapping’. 

   

To use, click the ‘Enable Snapping’ option and then select either of the ‘Measure’ tools. A 
circle around the mouse cursor appears and the vertex (white square) will snap to the 
existing markup edge. 

 

 
 

 
 

 

 

 

 

Only drawn features can be used for snapping. BCGW layers are not 
enabled for snapping in the BCGW. 



49 
 

Select Snapping 
Layers are currently not enabled for snapping in iMapBC. The functionality will be added in 
a later update. 

 

Find 
The ‘Find’ tab contains a variety of tools designed to search and analyze information. 

 

 

 

 

 

Identify tools 
The ‘Point, Freehand, Line, Polygon, and Rectangle Identify’ tools are to get more info from 
an area. You can learn which layers apply in that area and more. All the ‘Identify’ tools 
follow the same basics. The 'Polygon’ Identify tool is used in the example below. Each of 
the 'Identify' tools is described in the table at the end of this section. 

 

 

 

 

 

 

 

 

 

 

 

1. On the ‘Find’ tab, click the ‘Polygon’ identify tool. 
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2. Click on the map to start drawing the feature. When the last point of the polygon is 
ready to be placed, double click on the map to finish the shape.  
 

3. The polygon will then disappear from the map, and the results will be shown in the 
'Identify Results' window. 

 

The ‘Identify Tool’ Actions: 

Tool Actions 

 Click ‘Point’ identify and then click any point on the map. Any features 
found at that point on the map are included in the process. 

 Click 'Freehand' identify and then draw in any direction on the map over 
the features that you want to include. When you finish drawing, the 
identify process begins. All the features that align with the line are what 
will be shown. 

 Click ‘Line’ identify and then drag across the map to draw a line. 
To continue the line but change direction, click the map and then drag in 
the new direction. To end the line, double-click. All the features that align 
with the line are included in the identify process. 

 Click ‘Polygon’ identify and then drag across the map to start a polygon. 
To change direction, click and drag in a new direction. A black shading 
appears under your mouse to indicate that the polygon is filling in the 
space of the area. 
Keep clicking until the shading has covered the area you want to include 
in the process. Double click to end the polygon. You do not have to 
complete the shape. If the shading covers the area, you can double-click, 
and the line will be completed. All the features beneath the shaded area 
are included in the identify process. 

 Click ‘Rectangle’ identify and then click on one corner of the area you 
want to define. Drag a square away from the corner you clicked. A black 
shaded square appears under the cursor. When your area is in the 
square, lift your finger from the mouse. All the features covered by the 
rectangle are included in the process. 

 

 
Scale dependencies still apply. If the layer name is grey, it is not visible 
and not included in the results. 



51 
 

Enable Buffering 
The ‘Enable Buffering’ option in the ‘Find’ tab lets you get data from around the 
shape you draw too. You can easily change how large the buffer distance is and 
consider that in your map. 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 

1. Select a tool to draw a shape on the 
map and draw your shape. 
 

2. When you are finished your shape 
double click the last line and the shape 
will disappear. Your results will appear 
in the information panel. 

 
3. Click ‘Enable Buffering’ in the tool bar. 

 
4. A new tab will appear along the bottom 

of the information panel, clicking that 
will bring up a new window in the 
information panel (pictured left).  

 
5. Input the distance you want, including 

unit of measurement, click continue 
and it will change your results. 
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Enable Snapping 
When drawing an identify shape, you can snap your points to existing markups 
on the map by clicking ‘Enable Snapping’ in the toolbar. Snapping makes it 
easier to follow to the exact points on the markup. To disable snapping click 
the same button, now labeled ‘Disable Snapping’. 

 

 

 

 

 

 

 

 

 

 

 

1. Choose a tool to draw a shape. 
2. Click ‘Enable Snapping’. 
3. A circle around the mouse appears and the vertex (white square) will snap to the 

existing markup edge. This prevents any overlap or missed area. 

 

 

 

 

 

 

 

Only drawn features can be used for snapping. BCGW layers are not 
enabled for snapping. 
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Select Snapping Layers 
Layers are currently not enabled for snapping in iMapBC. The feature will be added in a 
later update. 

 

Identifiable Layers 
The ‘Identifiable Layers’ option lets you select which layers the identify tool will 
query. Query in mapping terms is about setting conditions that will help you 
filter your data and get more specific results. 

 

 

1. Layers with a check mark will be 
returned in the search ‘Identify Results’ 
window. 
 

2. You can deselect any of the layers by 
clicking again to remove the check 
mark. 

 

Working with Results 
The ‘Identify’ tool, ‘Search Box’, and the ‘Query Tools’ show you results in the ‘Search 
Results’ window. The ‘Results’ window includes many different options. These options 
change the layers, and the way information is reported and shown. 
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Results Overview 
This section will cover all the menus relating to results and their presentation. 

 

 

 

 

 

 

 

 

 

 

Each feature in the area searched will be in the results list in the information panel. 

Click the ‘Results List Menu’ (to the left of the x) for other options (Shown below). You can 
also click on any of the results to get more information and zoom to it on the map 
window. 
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The advanced menu offers many features that can be confusing to users, here is a brief 
overview of the features. 

 
 

 
 
 
  

1. ‘Switch to Table’ shows your data in a 
table format. 
 

2. ’Zoom to All’ zooms in to see the full 
area you selected. 

 
3. ‘Show Buffer Options’ lets you check the 

other features around the identified 
spot. 

 
4. ‘Export to CSV’ and ‘Export to XLSX’ 

exports results to their file type and 
onto your computer. 

 
5. ‘Open Saved Results’ opens your last 

saved results lists. 
 

6. ‘Save Results’ saves the results list, 
which can be opened again by open 
saved results. 

 
7. ‘Combine Results’ adds saved results 

with the current results. 
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Detailed Result Menu Options 
Once you select a result the detailed result information is displayed. Along with displaying 
the detailed result information, the ‘Detailed Result Menu’ is available. 

 

 

 

 

 

 

 

 

 

 

 

1. ‘Show Expanded View’ gives full details for the point, from when the point was last 
updated, to their contact info.  
 

2. ‘Show Buffer Options’ allows the feature to be used to then ‘identify’ other features 
shown on the map. 
 

3. ‘Zoom to Feature’ zooms the map to the feature. 
 

4. ‘Pan to Feature’ moves the map to the feature without changing the map scale. 
 

5. ‘Remove from Results’ removes the feature from the ‘Results List’. 
 

6. ‘Copy to Drawing Layer’ adds the specific point to your results when drawing on the 
map. 
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List View and Table View 
The ‘List View’ and ‘Table View,’ options are two different ways of viewing search results. 
This will show you all the options advanced menu offers. 

 

 
 

 
 

1. The ‘List View’ is the default view for the 
viewing the ‘Results List’, always shown 
on the information panel. 
 

2. Click the button (to the left of the x) to 
open the advanced menu. 

 
3. ‘Switch to List’ switches the results to 

list format. 
 

4. ‘Show Buffer Options’ lets you use 
buffer to ‘identify’ other features shown 
on the map. 

 
5. ‘Export to CSV’ exports the results to a 

CSV (comma separated values) file for 
external use. 

 
6. ‘Export to XLSX’ exports the results to a 

Microsoft Excel file for external use. 
 

7. ‘Open Saved Results’ opens a previously 
saved results list. 

 
8. ‘Save Results’ saves the results list so it 

can be used later. 
 

9. ‘Combine Results’ allows for many 
saved result lists to be combined. 
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Get to the ‘Switch to Table’ view option by using the ‘Identify’ tool on your data, clicking 
‘Results List Menu’ option and selecting ‘Switch to Table’. This version shows points in 
much more detail. 

 

 
 

 

 1. From the advanced menu, click on 
‘Switch to Table’, this will open table 
view for your data (pictured below). 
 

2. Features are shown in a table 
format and sorted by layers. Switch 
to other layers by clicking the tab 
along the top of the ‘Table View’. 

 
3. Scroll through all the attributes / 

text information for the feature by 
using the slider at the bottom of the 
‘Table View’. 

 

Open Saved Results 
The ‘Open Saved Results’ function allows the user to access, edit, and delete saved result 
lists. To view the ‘Saved Results’ screen, click the ‘Results List Menu’ and select the ‘Open 
Saved Results’ option. 

 
 
 
 

 
 

1. Click ‘Open Saved Results’. 
 

2. Click on a saved ‘Result List’ to open 
the list. 

 
3. Click ‘Edit List Name’ to rename the 

result list.  
 

4. Click ‘Delete List’ to remove the result 
list from the Saved Results screen. 
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Save Results 
The ‘Save Results’ function allows the user to save a result list to the project. 

 
 

 

1. To save a result list to your project, click 
‘Results List Menu’ and select ‘Save 
Results’. 
 

2. Give the Result List a name and click 
‘Save’. 

 

Combine Results 
‘Combine Results’ lets you change results lists and all their information. You can add 
results together, subtract them, or matching results from two lists. 
 

 
 

 

1. To combine result lists, click the ‘Results 
List Menu’ and click ‘Combine Results’. 
 

2. The ‘Combine Results’ screen will open. 
 
 
 
 
 
  
 
 
 
 
 
 
 



60 
 

Add to Results 
Continuing from ‘Combine Results’, ‘Add to Results’ combines a saved set with your 
current result list. 

 
 
 

1. Once you have made your current 
select, click ‘Results List Menu’ and 
select ‘Combine Results’. 
 

2. ‘Combine Results’ screen will open. 
Select ‘Add to Results’. 

 
3. Put a check next to the saved result list 

to combine with your current selection. 
Click ‘OK’. 

 
4. Your results will be combined. 
 

  
  

Current Result List Saved Result List Combined Result List 

 

 

 
 

 

 

 

 

If a feature is selected in multiple result lists, it will only exist 
once in the final combined result list. 
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Subtract Saved Results 
‘Subtract Saved Results’ removes specific data from your current list. 

 

 
 

 
 

 

1. Once you have made your current 
select, click the ‘Results List Menu’ and 
select the ‘Combine Results’ option. 
 

2. The ‘Combine Results’ screen will open. 
Select the ‘Subtract saved results’ 
option. 

 
3. Put a check next to a saved result list to 

subtract from your selection. Click ‘OK’. 
 

4. It will remove everything captured from 
the first list that is also in the 
subtracted list. 

 

Current Result List Subtracted Result List Final Results List 
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Match Intersecting Results 
‘Match Intersecting Results’ returns a list of results of only features that match between 
your current selection and selected saved result lists. 

 

 
 

 
 

 

1. Once you have made your current 
select, click the ‘Results List Menu’ and 
select the ‘Combine Results’ option. 
 

2. The ‘Combine Results’ screen will open. 
Select the ‘Match intersecting results’ 
option. 

 
3. Put a check next to a saved result list to 

subtract from your selection. Click ‘OK’. 
 

4. Only the features that exist in both lists 
will be returned to the final intersecting 
result list. 

 

Current Result List Saved Result List Intersecting Result List 
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Feature Location 
‘Zoom to Feature Location’ shows a list of geographic areas that can be zoomed 
to in two-steps: 

 

 
 

 

1. Pick the geographic area you would like 
to zoom to and click ‘OK’. 
 

2. A second pick list will be presented with 
specific features from the layer 
selected. Select the feature from the 
specific features pick list and click ‘OK’. 

 
The map will then be zoomed to the 
selected feature’s location. 

 

 

 

 

 

 

 

 

 

This tool does not add the layers to the map window. Use the 
‘Add Provincial Layers’ tool to add the layers to view them in the 
map window. 
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Query attribute values are case sensitive. The list of generated 
attribute values is not. It is usually best to select an option 
provided from the drop-down list of results to ensure your query 
uses the correct attribute value. 

Select by Query 
‘Select by Query’ lets you make queries without knowing how to write SQL 
statements. Results are show in the information panel, like ’Identify’ results. 

 

 

1. Click the ‘Select by Query’ tool under the ‘Find’ tab. 
 

2. Select the layer you want to query from the ‘Data Source’ drop-down list. 
 

3. Pick the attribute from the ‘Field’ list that you want to include in the first part of 
your query statement. For example, select ‘Park Class’. 
 

4. From the ‘Operator’ drop-down list, pick the operator. For example, select ‘=’ in the 
‘Value’ field, and type in the value you want to query. For example, type ‘Cla’. As you 
type, a list of options for this value will become displayed. 
 

5. If you want to make the statement more specific, click ‘Add Another Condition’ and 
define another set of parameters. 
 

6. To remove a condition, click the ‘X’ icon. 
 

7. Optionally, a ‘Spatial Filter’ can be added in ‘Map Area’, This lets the user define if 
the query will only search in the map extent or map drawings. 
 

8. Click ‘Search’. Your query results will be shown in the information panel on the 
right. 
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The Identify tools will not give results for items affected by a 
filter. 

Filter by Query 
 ‘Filter by Query’ lets you make conditions that will hide features on a layer that 
do not meet them. 

 

 
 
 

1. Click ‘Filter by Query’ under the ‘Find’ 
tab. 
 

2. Select the layer you want to query from 
the ‘Data Source’ drop-down list. 

 
3. Select the field from the ‘Field’ drop-

down list that you want to include in 
the first part of your conditions. For 
example, select ‘Projected Height’. 

 
4. From the ‘Operator’ drop-down list, 

select the operator. For example, pick 
‘>’. In the ‘Value’ field, type in the value 
you want to query. Type ‘20’. As you 
type, a list of possible options for this 
value will be shown. 

 
5. If you want to make the statement 

more specific, click ‘Add Condition’ and 
set its conditions. 

 
6. A ‘Spatial Filter’ can be added in ‘Map 

Area’. This allows the user to define if 
the query will only search in the map 
extent or map drawings. 

 
7. Click ‘Filter’, and your filter will be 

shown in the map window. 
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Help 
Users may require additional information regarding the iMapBC application. Additional 
help can be accessed using this section. 

 

Help Tab Tools 
The ‘Help’ tab contains tools that allow the user to get more information 
regarding iMapBC. Clicking ‘Support Material’ brings you back to the iMapBC 
launch page with reference materials. 

 

 
 

1. The Data Catalogue Record links you to 
the Metadata page for iMapBC. 
 

2. The ‘FAQ’ tool opens the iMapBC 
Frequently Asked Questions PDF in a 
separate window. 

 
3. The ‘Training Manual’ tool opens the 

iMapBC training manual in another 
window. 

 
4. The Map Projection Files is a quick 

download in the form of a ZIP file. 
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Questions or Reporting Issues with iMapBC 
Issues with iMapBC can be reported to the Natural Resource Ministries Helpdesk: 

Hours of Operation: 8:00 a.m. - 4:00 p.m. (PST/PDT), Monday to Friday (excluding holidays) 

Phone (within Victoria): 250-952-6801 (Option 1) 

Toll Free (within BC): 1-866-952-6801 (Option 1) 

NRMenquiries@gov.bc.ca 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

mailto:NRMenquiries@gov.bc.ca
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Appendix A: Training Exercises 
These are some exercises that will help you understand iMapBC better. 

 

Exercise 1: Search for an Address 
Search for an address in Bella Coola. 

 

 

 

 

 

 

 

 

 

 

1. Type ‘450 MacKenzie St’ in the Search Box. 
2. Click the ‘Begin Search’ icon. 

 

When the results come back, click on the address listed as 450 MacKenzie St, Bella Coola, 
BC. It will zoom to there and give you some more information. 

 

- End of exercise – 
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Exercise 2: Change Point Symbology 
Change the size and colour of the Major Cities on the map. 

 

 
 
 
 
 
 

 

1. On the ‘Data Sources’ tab, click ‘Add 
Provincial Layers’. 
 

2. Under Base Maps, put a check next to 
‘Major Cities – 7.5M’ and click ‘OK’. 

 
3. Click the ‘Layers’ Information Panel 

Icon. 
 

4. In the Layers list, click the arrow to the 
right of the ‘Major Cities – 7.5M’ layer. 
 

5. In the Layer Options screen, select 
‘Turn on/off layer Visualization’. 
 

6. In the Visualization Options screen, 
change it to ‘Custom Layer Style…’. 
 

7. Change the Marker Size to ‘16 px’. 
 

8. Change Marker Style to ‘Square’. 
 

9. Click ‘Apply’, then ‘Done’. 
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- End of exercise – 
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Exercise 3: Symbolize by Attribute 
 Show the different kinds of public schools on a map with this exercise. 

 

 

 

1. On the ‘Data Sources’ tab, click the ‘Add Provincial Layers’ tool. 
2. Under Education > Schools-Public, put a check next to ‘Schools-Public-All’ and click 

'OK'. 

 3. In the Layer Options screen, select 
‘Turn on/off layer Visualization’. 
 

4. Change the visualization it to ‘Custom 
Layer Style…’. 

 
5. ’Change ‘Choose Symbology Type’ to 

‘Attribute’. 
 

6. Set the ‘Pick an attribute to symbolize’ 
field to ‘School Type’. 

 
7. Change the Marker Size to ‘16 px’. 

 
8. Change the Marker Style to ‘Circle’.  

 
9. Change the Colours by clicking on each 

class. Click ‘Apply’. 
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The layer visualizations will be updated in the map window (shown above). 

 

- End of exercise – 
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Exercise 4: Provincial Layer Download 
 Use this exercise to learn more about school locations and school districts. 

1. In the ‘Data Sources’ tab, click ‘Add Provincial Layers’. 
 

2. Under Education > ‘Schools-Public, put a check next to ‘Schools-Public-All’. Then 
click Education > School Districts, put a check next to ‘School Districts – Colour 
Filled’ and click ‘OK’. 
 

3. In the ‘Export’ tab, click ‘Provincial Layer Download’. 
 
 

 4. In the Data Download Service 
screen, click ‘Select All’ or click each 
of the toggles for the School 
Districts – Colour Filled and Schools-
Public layers. 
 

5. Click ‘Prepare Order…’, a new 
window will open. 

 

 

6. In the Order Details window: Set the Coordinate System to ‘BC Albers (m)’. Set the 
Format to ‘ArcView Shape’. 
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7. Set the Area of Interest to ‘Draw a Custom AOI’. 

 
8. Click ‘Draw a Custom AOI’. 

 
 

9. The AOI Selector map window opens. In the search box, search ‘Kamloops’. 
 

10. In the Search Results screen, click the top result titled ‘Address: Kamloops, BC’. 
 

11. Click in the scale box and set the scale to ‘1:72,224’. 
 

12. Click the rectangle option in ‘Select Area of Interest’. 
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13. Click ‘Draw Rectangle’ and click and drag in the map window to draw a rectangle, 

like the one shown above. 
 

14. When you are done the Select Area of Interest window will display ‘Geometry 
Captured’. Click ‘Next’, then ‘Submit AOI’. The order details screen will reopen. The 
% of Max size will be updated. 
 

15. Enter your Email and agree to the Terms and Conditions. 
 

16. Click ‘Submit Order’. 
 

17. You will get two emails, the order submission email, and the order assembled 
email. In the order assembled email, click the provided URL to see your 
information. You may need to enter your login credentials if you used the 
username required version of iMapBC. 

 

 

 

 

- End of exercise – 

 

 

 

 

 

 

 

 

If you cannot see ‘Submit Order’ and there is no slider bar, you 
will need to press the ‘Ctrl’ and ‘-‘ (minus) keys together to 
reduce the browser window text size. 
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Exercise 5: Select by Query 
Output a list of all Crown Tenures for Agriculture under lease. 

 

 

 

 

 

 

 

 

 

 

1. Under ‘Data Sources’, click ‘Add Provincial Layers’. 
 

2. Under Land Ownership and Status > Crown Tenure – All – Tantalis, put a check next 
to ‘Tenures – Tantalis – Colour Filled’ and click ‘OK’. 
 

3. In the ‘Find’ tab, click ‘Feature Location’. 
 

4. Select ‘Municipality’ and click ‘OK’. Select ‘100 Mile House’ and click ‘OK’. 
 

5. Set the scale to ‘1:288,895’. 
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6. In the ‘Find’ tab, click ‘Select by Query’. In the Query builder dialogue box, set the 
Data Source to ‘Tenures –Tantalis – Colour Filled’. 
 

7. Set the Field to ‘Tenure Purpose’. 
 

8. Set the Operators to ‘=’ sign. 
 

9. In Field Value text box, type the word ‘Agriculture’. 
 

10. Set the Map Area option to ‘Current Extent'. 
 

11. Click ‘Search’. 
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12. The query found 26 results (your results may change slightly as the number of 
results can change based on screen size or updates to the data set). Do not click on 
any of the search results. Your map view will change, and the rest of this exercise 
will not work. If your map view has changed return and do step 4 and 5. Zoom back 
to extent 1:288,895 at 100 Mile House and then go to step 13. 
 

13. To narrow the query to agriculture tenures that are leased, click the ‘Query’ 
Information Panel Icon. 
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14. Click ‘Add Another Condition’. 
 

15. Set the Field to ‘Tenure Type’. 
 

16. Set the Operators to ‘=’. 
 

17. In Field Value text box, type the word 
‘Lease’. 

 
18. Click ‘Search’. Notice the results this 

time are 10 (your results may change 
slightly as the number of results can 
change based on screen size or 
updates to the data set). 

 
19.  In Query Results, click ‘Options’ and 

select ‘Switch to Table’. 
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20. In the Table View screen, click ‘Options’ and select ‘Export to XLSX’. 
 

21. In the confirmation window, click ‘OK’. When the download window appears, click 
‘Open’. The results will open in Excel. 

 

- End of exercise – 
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Exercise 6: Filter by Query 
View all vegetation polygons around Prince Rupert over 325 years old. 

 

 

 

 

 

 

 

 

 

1. In the ‘Find’ tab, click the ‘Feature Location’ tool. 
 

2. Select ‘Municipality’ and click ‘OK’. Select ‘Prince Rupert’ and click ‘OK’. 
 

3. Click in the scale box and set to ‘1:36,112’.  
 

4. In the ‘Data Sources’ tab, click ‘Add Provincial Layers’. 
 

5. Under Forest Grasslands and Wetlands > Vegetated Land Cover, put a check next to 
‘Vegetated Land Cover – Projected Age’ and click ‘OK’. 

 

 

 

 

 

 

 

 

 

If you cannot see the text field, you can readjust the 
information panel width by clicking and dragging the 
‘information panel adjustor’ icon. 
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6. In the ‘Find’ tab, click ‘Filter by Query’. 
 

7. Set the Data Source to ‘Vegetated Land 
Cover – Projected Age’. 

 
8. Set the Field Name to ‘Projected Age’. 

 
9. Set the ‘Operators’ to ‘(>)’. 

 
10. In the Field Value text box, type the value 

‘325’. 

 

 

 

 

 

 

 

 

 

 

 

11. Click ‘Filter’. The map will now only show vegetation stands that are over 325 years 
in age. All vegetation stands equal or less than 325 years old will not be shown on 
the map. 

 

 

- End of exercise – 
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Appendix B: Finding Content on the DataBC Site 
The DataBC Geographic Services web site is the starting point for many services. Try 
searching the website. 

 

Data Distribution Service 
Select and request datasets in a specific file format. This service lets you change the data 
you have in different ways. You can change file formats, look at specific places on the map, 
change projections and more. 

 

Web-based Mapping 
Look at all B.C. geographic information using web-based map tools and map services. 

 

Location Services (B.C. Physical Address Geocoder, Geomark Web 
Service, BC Geographical Names Web Service) 
Web services that locate things in BC. You can find civic addresses, areas of interest, place 
names and routes from point A to B. These services are meant to be used by businesses. 

 

Topographic Data 
Topographic data shows British Columbia's terrain, elevation, and land features. The 
topography of B.C. is used to create maps of the provincial land base. 

 

Land Use 
The Provincial Government manages all data determining land ownership, rights, and 
jurisdiction in British Columbia. Land that can be owned in B.C. is divided into parcels. 
Land parcels may be owned by governments, companies, organizations, or persons. A 
cadaste is a register that describes the ownership, location, and dimensions of land 
parcels. 

 

 

https://www2.gov.bc.ca/gov/content/data/geographic-data-services
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Digital Imagery 
Imagery provides a sense of the current state of a place, as well as a view into its past 
condition. Visual data is important for measuring effects on the land of British Columbia. 
High-resolution images are useful for mapping, research, emergency planning and 
natural resource management. Anyone can access these images, which show how the 
province has changed. 


